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1 INTRODUCTION

1 Introduction

1.1 Contact

igus® GmbH

Spicher Str. 1a

D-51147 Köln

Tel.: +49(0)2203 / 96498-255

E-Mail: ww-robot-control@igus.net

Internet: www.igus.eu
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1 INTRODUCTION

1.2 Intended Use

The intended use of the product is defined by the uses within the defined limits from the technical
data. The permissible electrical parameters and the defined permissible ambient conditions must be
observed in particular. These are specified in more detail later in this manual.
The intended use for this product can be found in the following section 3.

1.3 Target Group and Qualification

The product and this documentation are intended for technically trained professionals such as:
• development engineers
• plant designers
• assemblers/service personnel
• application engineers

Installation, commissioning, as well as operation is only allowed by qualified personnel. These are
persons who meet all the following requirements.

• have appropriate training and experience in handling motors and their control.
• know and understand the contents of this technical manual.
• know the applicable regulations

1.4 Symbols Used

All notes in this document follow a consistent form and are structured according to the following
classes.

,
The WARNING notice alerts the reader to possible dangerous situations.
Disregarding a warning can possibly result in moderate injury to the user.

• Within a warning, this describes ways to avoid hazards.

ð
This note indicates possible incorrect operation of the product.
Failure to comply with this notice may possibly result in damage to this product
or other products.

1.5 Product Safety

The following EU directives were observed:
• RoHS-Directive (2011/65/EU, 2015/863/EU)
• EMV-Directive (2014/30/EU)

1.6 Regulations

In addition to this technical manual, operation, commissioning is subject to the applicable local reg-
ulations, such as:

• Accident prevention regulations
• Local regulations for occupational safety

©2022 igus® GmbH 6



2 SYSTEM OVERVIEW

2 System Overview

The robot controller described here is part of a robot system that consists of four basic components:

1. Robot: the mechanical robot arm, gantry, delta robot, scara robot, etc ...

2. Robot control: modular robot controller consisting of embedded computer, stepper motor
driver modules for controlling the robot axes and IO modules.

3. Robot control software: Control software for moving the robot and executing robot programs.

4. Programming environment: Graphical software for setting up robot programs

The robot controller is used to control the movement of the robot’s motors. The robot controllers
are available with 48V motor voltage or 24V motor voltage. The stepper motor driver modules are for
bipolar stepper motors of different sizes and configurable, or preconfigured. For precise positioning
and control, quadrature encoder signals are normally read in, which feed back the actual motor or
axis position to the stepper motor driver modules. In addition, different referencing methods and
movements are supported to transmit the "actual position" of the robot to the software after a cold
start of the robot system. Different inverse kinematics are supported in the software, so that e.g.
controlled linear movements of a robot arm are as easy to program as those of a gantry robot.

Figure 1: Robot system - Robot, robot controller with integrated computer and optional handheld
pendant. Separate Windows PC connected to the robot controller via LAN with iRC control software
and programming environment. The Windows PC is required for programming the robot. Robot
programs can also be executed without a Windows PC, since the robot controller uses the integrated
computer as the control computer.

2.1 Supported Kinematics

The control hardware and software support a variety of kinematics that allow controlled movement
of the robot. The following inverse kinematics are preconfigured.

• 2 axis delta robot
• 3 axis delta robot
• 2 axis gantry robot (X and Y axis)
• 2 axis gantry robot (Y and Z axis)
• 3 axis gantry robot (X, Y and Z axis)
• 3 axis robot arm (axis 1, 2, 3)

©2022 igus® GmbH 7



2 SYSTEM OVERVIEW

• 3 axis robot arm (axis 2, 3, 4)
• 4 axis robot arm (axis 1, 2, 3, 4)
• 4 axis robot arm (axis 2, 3, 4, 5)
• 5 axis robot arm (axis 1 to 5)
• 6 axis robot arm (axis 1 to 6)
• 4 axis SCARA robot

A complete list of supported robot models can be found in the "Open Project" section of iRC. In ad-
dition, up to three kinematically independent additional axes can be configured in iRC.

2.2 Specifications

Modular Control Feature
Power supply 24V/5A and either 24V/10A or 48V/10A

. Type DIN rail modules with 5-pole bus connector

Communication with control com-
puter

CAN

Stepper motor module For operation of a bipolar stepper motor

quadrature encoder RS422

12-24V reference switch input

Digital IO module 7 digital inputs (optocoupler)

7 digital outputs, solid state relay, max 500 mA

Table 2: Modular Robot Control - Components

The features of the embedded control can be seen in the table 3.

Embedded control Features
Type Single board computer with daughter module

Power supply 24V/1A

Operating system Linux based

Software TinyCtrl robot control software

Interfaces CAN Bus (connection to the modules)

Ethernet (connection to Windows PC)

RS232 display connection

Digital inputs for enabling switch

DC/DC converter 5V/4A

Table 3: Integrated Computer - Specifications

This table lists the mechanical dimensions of the individual components in the control cabinet, as
well as the control cabinet itself.

©2022 igus® GmbH 8



2 SYSTEM OVERVIEW

Objekt L x B x H (mm)
control cabinet 600 x 300 x 155

control modules 100 x 22 x 92

embedded control 90 x 72 x 75

power supply 24V/10A 120 x 87 x 125

power supply 24V/5A 120 x 40 x 125

power supply 48V/10A 120 x 87 x 140

operation tablet 205 x 110 x 110

Table 4: Modular robot control - dimensions

©2022 igus® GmbH 9



3 SAFETY INSTRUCTIONS

3 Safety Instructions

,
Operate the robot carefully!
When operating a robot arm or commissioning a robot cell, always pay attention to the
personal safety of the users and other persons! In particular, there must be no persons
or obstacles in the working area of the robot.

• In the basic version, the robot control package does not contain any safety-related functions.
Depending on the application, these may have to be added. See also "CE marking" below.

• CE marking: The robot arm and robot controller are part of a system that must be risk assessed
in its entirety and comply with the applicable safety regulations to ensure personal safety. De-
pending on the outcome of the assessment, other safety components may need to be inte-
grated. These are usually safety relays and door switches. The engineer commissioning the
system is responsible.

• Depending on the equipment, the robot controller contains either a 24V/5A and a 24V/10A
power supply or a 24V/5A and a 48V/10A power supply, which themselves require mains voltage
(120 V / 240 V) depending on the configuration. Please check the label on the power supply.
Only qualified personnel may connect the power supply to the mains and put it into operation.

• Work on the robot electronics should only be performed by qualified personnel. Check the
guidelines for electrostatic discharge (ESD).

• Always disconnect the robot controller from the mains (120 V / 240 V) when working in the
control cabinet or on electronics connected to the robot controller.

• DO NOT hot plug! This can cause permanent damage to the motor modules. Do not install
or remove any modules or connectors (e.g. manual control unit, emergency stop switch, DIO
modules or external relays, motor connections...) while powered up.

• The robot arm must be set up on a robust surface and screwed down or otherwise secured.
• Use and store the system only in a dry and clean environment.
• Use the system only at room temperature (15° to 32°C).
• The ventilation of the system must be able to work unhindered to ensure sufficient air flow for

cooling the stepper motor modules. There must be at least 10 cm of space next to the fan of the
robot controller. The fan must ideally point upwards or to the side (reduced efficiency). The fan
must not point downwards.

• Save important data before installing the iRC - igus Robot Control.
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4 CE-Conformity

4.1 CE marking

The modular robot controller is CE marked according to the RoHS, Low Voltage and EMC directives.
The complete machine, i.e. the complete robot cell, is not covered by this CE marking. The complete
machine is documented by the integrator as a complete system, assessed for risks and provided with
a CE marking according to the Machinery Directive.

,
Creation of CE marking necessary! For the operation of the complete machine
a CE marking according to the machine guideline must take place! This is car-
ried out by the integrator or commissioning engineer!

4.2 Integration of safety components to establish CE conformity

The simplest way to establish the personnel safety required for CE conformity is to integrate safety
components with the appropriate PL or SIL rating:

• Safety relay or safety control
• emergency off and door switch
• enclosure

The modular robot controller itself does not provide any safety functions. It does not carry a PL or SIL
rating.

Two power supplies are provided in the controller, one for the logic (24V/5A), the other for the motor
currents (24V/10A or 48V/10A). The first power supply should work continuously, the second one
should be deactivated in case of emergency stop.

ð
Do not interrupt the logic voltage! In case of emergency stop, the interruption
of the motor voltage leads to a stop of the motors. The logic power supply for
the Integrated Control must not be interrupted. Thus, the program can be con-
tinued or restarted after an EmergencyStop is released again without startup or
referencing. For further details, refer to the circuit diagram of the control.

For this purpose, a relay or contactor can be used before or after the power supply:
• As delivered: On the AC side, that means before the power supply.
• Optional: On the DC side in the 24 or 48V circuit. The relays used for interupting the current

need to be rated for high DC currents of >10A. Furthermore it is mandatory to integrate an
current limiter to avoid current spikes on the bus while loading the condensators.
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5 Requirements

5.1 Environmental Conditions

Ambient conditions Wert
Protection class IP20

Ambient temperature (operating) +10. . . +32°C

Ambient temperature (storage) -10. . . +85°C

Humidity (non-condensing) 0. . . 90%

Installation height above sea level (without power restriction) 1500m

Table 5: Ambient conditions

5.2 Software Requirements

To use iRC a computer with the following features is required:
• PC (min. Intel i5 CPU) with Windows 10 or 11 (64 Bit)
• .NET Framework 4.7.2 or newer
• at least 500MB free disk space
• graphics card (integrated or dedicated)

– OpenGL 3.0 or newer
– manufacturer driver (the standard Microsoft driver is not supported)

• a free Ethernet port
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6 Quick Start Guide

6.1 Set up and Connect

,
Before Starting the Work
To avoid injuries as well as damage to the components, observe the following
instructions:

• Follow the safety instructions in section 3.
• Disconnect the robot or the controller from the mains. Never work on

live parts. Work on control cabinets may only be carried out by qualified
electricians.

• No hot plugging! Before plugging in or disconnecting modules/plugs/-
electrical connections, disconnect the controller/robot from the mains.

• Ensure a safe stand of the robot and the controller.
• Observe the requirements for the environment 5.1.
• During the movements of the robot, no persons may be in the working

area of the robot.

To set up and commission the robot, proceed in the following order:

1. Make sure that the controller is disconnected from the power supply: Unplug the power cord.

2. Mount the robot on a suitable base. Make sure that the cables are not under tension.

3. Feed the robot cables through the large circular hole in the control cabinet and plug them into
the stepper motor modules. Each motor with its associated reference sensor is connected to its
stepper motor module via 4 connectors (see Fig. 13). All connectors are labeled and coded to
support this process. The following cables each belong to a motor the affiliation between motor
and cable set is also numbered on the connectors:

• motor cable (with the designation motor)
• encoder cable (2 connectors labeled ENC-1 and ENC-2)
• reference sensor (labeled End-Stop)

4. Connect the shield and ground wires of the encoder and motor cables, if present.

• motor cable ground: green-yellow
• encoder shield (ground): black

5. All motor and encoder cable ground wires are plugged into the ground block next to the con-
troller.

6. Secure the robot cables against voltage, e.g. with a cable tie to one of the holes in the control
cabinet. If present, plug in the teach pendant cable and secure it via the screw connection.

7. The robot is ready to be switched on after completing these steps.
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Figure 2: Three motor modules with 4 connectors per module, each leading to a motor and the cor-
responding reference sensor. Also in the picture: a digital I/O module (module on the right), which is
not wired.

6.2 Switch On

,
Danger of Electric Shock! Before commissioning the components, make sure
that all cables and control cabinet components are properly connected. Check
all cables for tight fit and make sure that there are no loose cables in the control
cabinet.

1. Connect the robot to your power supply using the enclosed power cable.

2. Switch on the robot using the On/Off switch on the control cabinet.

3. The green light emitting diodes (LEDs) on the modules will now light up, as will most of the red
LEDs and possibly some of the yellow LEDs.

4. After the control computer has finished booting (after about 60s), the green LEDs will start
flashing. This indicates communication with the modules. Now the robot controller is in oper-
ation. If available, you can now move the robot via the optional handheld operating device (see
section 9).

6.3 Connecting and moving the robot

6.3.1 Preparation with the integrated computer

The following steps establish the LAN connection between the robot controller and the Windows PC.

1. Connect your PC to the robot controller using an Ethernet cable. Use the Ethernet port located
right next to the USB socket on the integrated computer (see Fig. 3) of the robot controller.

2. Set the IP address of the PC to: static and 192.168.3.1 with a subnet mask of 255.255.255.0.
Instructions for changing the IP address of your computer can be found on the Internet under
the keyword "Change IP address Windows 10"..
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Figure 3: Integrated control computer with LAN cable.

6.3.2 Moving the Robot for the First Time

1. Install the iRC software on your PC.

2. Start the iRC software. At startup, you can select the project that applies to your robot. Please
refer to the product number or product name, the project names are based on these (see Fig.
4).

3. You can now activate the robot by pressing the following buttons in the given order (see also
Fig. 5):

3.1 "Connect"

3.2 "Reset"

3.3 "Enable"

4. Now the status LED light on the left in iRC should be green and the status should show "No
Error".

5. You can now move the robot’s joints using the buttons on the "Jogging" tab (see Fig. 5).

ð
Cartesian movements and programs
For the use of Cartesian commands and the playing of robot programs a refer-
encing of the robot is mandatory.
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Figure 4: Choosing a project

Figure 5: Jog Commands
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7 Installation

For the detailed pin assignment, please refer to the circuit diagram of the robot controller. The pin
assignments in this chapter are intended exclusively for better illustration. Always consult the circuit
diagram for the connection assignment.

7.1 Overview

Figure 6: Robotersteuerung: Shown here with 5 stepper modules and 3 DIO modules. In addition
optional 24V/5A and 48V/10A power supplies for logic and motor voltage are shown. Detailed pin
assignment in the separate circuit diagram.

7.2 Motor Module

Each stepper motor module drives a bipolar stepper motor with motor encoders. The encoder signals
are evaluated by an RS422 module. The signals for each axis run over three cables: motor cable, en-
coder cable and reference switch cable. The motor cable is connected to a connector labeled "Motor",
the encoder cable is connected to two connectors labeled "ENC 1" and "ENC-2", and the reference
switch cable is connected to the connector labeled "End-Stop".

Figure 7: Motor module with connectors

Motor connector ("Motor"): Connects a bipolar stepper motor:
• Pin 1 (left): B (blue)
• Pin 2: A (white)
• Pin 3: B/ (black)
• Pin 4: A/ (brown)
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7 INSTALLATION

Encoder connector 1 (ENC-1): Connects a quadrature encoder to an RS422 device.
• Pin 1 (left): A (white)
• Pin 2: 5 V DC (red)
• Pin 3: B (green)
• Pin 4: 0 V (grey)

Encoder connector 2 (ENC-2): Connects a quadrature encoder to an RS422 device.
• Pin 1 (left): A-N (brown)
• Pin 2: B-N (yellow)
• Pin 3: index (rose)
• Pin 4: index-N (blue)

cAll eight wires (encoder connectors 1 and 2) must be connected to read out the encoder.
End-Stop connector: Connected to a limit stop or reference switch.

• Pin 1 (left): 24 V (brown)
• Pin 2: Ground (GND) (blue)
• Pin 3: Signal (black)
• Pin 4: not connected

7.3 Digital I/O Module

The DIO module provides input and output channels, e.g. for controlling a gripper valve. The out-
puts can switch up to 500 mA. The inputs use optocouplers and are compatible with input voltages
between 12 and 24 V.
A circuit switched by the output relays must not contain larger capacitors. If the current exceeds 500
mA, the solid state relays may be damaged.
For safety reasons, the inputs and outputs of the DIO module are galvanically isolated. This means
that the circuits of the inputs and outputs are not connected to the internal circuits of the controller. It
is therefore necessary to connect a supply voltage for the outputs and a ground line for the inputs. For
this purpose, the 24 V available in the robot controller can be used, but also an external independent
voltage source. In the software, the inputs and outputs of the first DIO module are numbered 21-27,
of the second DIO module (if supplied) 31-37 and of the third 41-47.

Figure 8: DIO module with connectors

Digital-Out connector A (D-out A): The output relays connect the power supply pin to the correspond-
ing output pins.

• Pin 1 (left): Supply for all seven channels
• Pin 2: D-Out channel 1 (in software: Dout21)
• Pin 3: D-Out channel 2 (in software: Dout22)
• Pin 4: D-Out channel 3 (in software: Dout23)
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Figure 9: Embedded control

Digital Out Connector B (D-out B): The D-out B pins are (from left to right) Digital Out channels 4-7
(image not shown).
Digital-In connector A (D-in A): Pin 1 in D-In A is the ground pin for all input pins.

• Pin 1 (left): Signal ground for all 7 channels
• Pin 2: D-In channel 1 (in software Din21)
• Pin 3: D-In channel 2 (in software Din22)
• Pin 4: D-In channel 3 (in software Din23)

Digital-In connector B (D-In B): The D-In B pins are (from left to right) the digital-in channels 4-7
(picture not shown).
Section 11.3 provides further information on extending the DIOs and on connecting sensors or actors.

7.4 Motor Brakes

To prevent an axis from dropping, electromagnetic brakes can be used. The necessary configuration
is described in section 11.4.

7.5 Embedded Control

An integrated computer is combined with the modular robot controller so that an external computer
is only required for programming, but not for daily operation. The Windows software (iRC) basically
communicates via LAN with the control software on the integrated computer (Linux). The control
software communicates via CAN with the modules of the robot controller.

7.5.1 Power Supply

At the connector "IN Supply" of the control computer (rightmost in figure 10) is connected (from left
to right):
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Figure 10: Bus and power supply connector. The "+24V Out" connector remains unused.

• Pin1: +24V
• Pin2: GND

7.5.2 Bus connection

The CAN connection is established via the middle 5-pin connector "OUT-BUS" (from left to right):
• Pin1: CAN-L
• Pin2: CAN-H
• Pin3: +5V logic supply for the modules
• Pin4: not connected
• Pin5: not connected

The bus connection is connected to the DIN rail modules (digital IO and motor modules) of the con-
troller. A support module is not compatible with this type of connection, as it would also feed +5V to
the same bus.
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7.5.3 LAN Connection to the Windows PC

Figure 11: LAN and display port. The USB ports remain unused.

Ethernet connection between control computer and Windows PC can be established via LAN cable.
The IP of the control computer is 192.168.3.11, subnet is 255.255.255.0.

7.5.4 Connection to the Manual Control Unit

The manual control unit (display) is connected to the 9-pin D-Sub connector. Attention! The con-
nection is proprietary. A null modem cable or similar cannot be connected here. The pin assignment
is as follows (the pins are numbered on the connector):

• Pin 1: GND
• Pin 2: CAN-L
• Pin 3: RS232 TX
• Pin 4: not connected
• Pin 5: +24V out
• Pin 6: GND
• Pin 7: CAN-H
• Pin 8: RS232 RX
• Pin 9: GND
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7.6 Handheld

Figure 12: Handheld control unit (touch display and 3-axis joystick)

The handheld control unit is used to control the robot via the integrated computer. The connector of
the D-Sub 9 plug must be connected to the D-Sub 9 socket of the control cabinet. The pin assignment
of the handheld terminal is as follows:

• Pin 1: not connected
• Pin 2: not connected
• Pin 3: RS232 RX
• Pin 4: not connected
• Pin 5: +24V input
• Pin 6: not connected
• Pin 7: RS232 TX
• Pin 8: not connected
• Pin 9: GND
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8 Moving the Robot with iRC

iRC - igus Robot Control is a control and programming environment for robots. The 3D user interface
helps to get the robot up and running quickly. Due to the modular structure, different kinematics and
motor drivers can be controlled.

8.1 The Graphical User Interface

This section explains the iRC software. All steps can be simulated even without a robot connected. In
section 8.2 the real robot is then connected and moved.
The programming environment iRC enables the control and programming of the robot. You can work
both online and offline, i.e. with the robot or in simulation (with the robot switched off or not con-
nected).

Figure 13: User interface of the iRC - igus Robot Control

In the upper left corner, the three tabs "File", "Scene", "Motion" and "Help" provide access to the
main functions. In the left corner, information about the current state of the physical robot is dis-
played. Additional functions like loading another project ("Open Project") or "Robot Referencing"
can be found in the "File" tab (see Fig. 13).
There are five tabs at the bottom of the window:

• "Log messages": Messages from the program about status or errors.
• "Infocenter": displays the axis values, Cartesian position and other information.
• "Jogging": keys to move the robot.
• "Input/Output": Display and set the DIO interfaces of the robot controller.
• "Programs & Variables": displays the current status of program variables.
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The "Help" icon in the lower right corner contains links to the wiki pages ("Online Doc-
umentation", "Software Updates", "Examples", "Troubleshooting") and a link to "Con-
tact Support". The log files of iRC and the integrated controller can also be accessed
here.

8.1.1 Selecting the type of robot

iRC provides project-related settings for different robot types, such as gantries, robot arms or delta
robots. Figure 14 shows the project open area, which can be used to load the corresponding project.

1. Click on the "File" tab in the upper left corner and select "Open Project".

2. Select the robot group, e.g. "robolink".

3. Make sure that the parameter set matching the operating voltage of the robot is selected. This
will affect the speed and acceleration.

4. Now click on the entry that matches your robot, e.g. RL-DP-5.

Figure 14: Selection of the robot type via the menu item "File" → "Open Project"

8.1.2 Navigation and movement of the robot in the 3D view

A 3-button mouse is recommended for navigating in the iRC - igus Robot Control 3D environment:
• Left button:

©2022 igus® GmbH 24



8 MOVING THE ROBOT WITH IRC

– Selecting icons and functions in the menu.
– Moving a robot axis: Place the cursor over a joint (it will be highlighted), then click and

move the cursor up and down while holding down the left mouse button.
• middle button/mouse wheel:

– Navigate the scene to rotate the robot: Move the cursor while holding down the middle
mouse button.

– Mouse wheel rotation: Zoom in/out to the current cursor position.
• Right button: move the image section.

The function of the left mouse button can be changed
in the "Scene" tab under "Navigate". The movement
options "Select", "Move", "Rotate" and "Zoom" are
available. "Reset" returns you to the home screen.

8.2 Connecting the robot

8.2.1 Hardware connection

The real robot can be controlled in the same way as the simulated one, only the hardware must first
be connected and activated by clicking the "Connect", "Reset" and "Activate" icons in the "Physical
Robot" button group in the "Motion" tab (see Fig. 15). After that, the robot must be referenced.

Figure 15: Buttons for connecting to the hardware, resetting errors and activating the motors, refer-
encing and "Status" display.

1. "Connect": Establish the connection to the hardware.

• This initializes the connection (mostly via Ethernet, in some cases via USB CAN adapter).
• The "Status" indicator on the left side changes from gray to red.
• Several error messages are displayed below the "Status" indicator.

2. "Reset": Resets the errors.

• This key is used to reset the error memories of the electronic modules of the robot con-
troller.

• The axis positions are transferred from the real robot to the simulation environment. The
3D visualization of the robot should now correspond to the current position of the real
robot.

,
This must be checked with every error reset! If the values do not match,
referencing must be performed, which is described in section 8.3.
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• The "Status" display remains red. The error messages are cleared, only "Motors not en-
abled" remains. If other error messages are displayed, try again and follow the instructions
in the robot documentation.

3. "Activate": Activation of the motors.

• The "Status" indicator is now green.

8.2.2 Move the robot

It is now possible to move the robot using the jog keys, a mouse in the user interface or a gamepad,
see section 8.4.

8.3 Referencing the robot

, • After startup, the robot must be referenced. Before referencing, the robot’s axes
can only perform motions in joint mode. This is to avoid collisions during unref-
erenced robot operation.

• Cartesian movements or the start of a program are only possible after referencing.
• The status is displayed on the left side of the iRC - igus Robot Control.

The motor modules store the position in an EEPROM. However, due to gravity or other forces, the axes
may move when the motor power is switched off. In this case, the motor modules no longer report
the correct position to the software. In order to synchronize the position between software, stepper
motor module and robot axis, referencing must be performed.

8.3.1 Step by step guide of referencing

1. Start the robot controller and the iRC - igus Robot Control.

2. Press the buttons "Connect", "Reset" and "Activate" (see fig. 15).

3. Click the "Reference" button (Fig. 15) in the button group "Physical Robot" in the "Motion" tab
(or "Robot Reference" in the "File" tab) to open the referencing window.

4. Click on the "Reference Axis" buttons to start referencing an axis, see Fig. 16. Multiple joints
can perform referencing in parallel.

5. You can also click on "Reference all", then the axes will start referencing in an order defined in
the project file.

6. Once all movements have been executed and the robot is at rest again, click on "Reset" and
"Activate". Now the robot is fully functional.

8.4 Moving the robot

The robot can be moved manually (or "jogged") when no program is running. The following options
are available for this purpose:

• Software keys
• dragging joints in 3D area
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Figure 16: Referencing of the axes.

• gamepad
The most important settings can be found in the "Movement" tab (see Fig. 17):

• "Input": Connecting a gamepad
• "Motion parameters": Selection of movement modes and speed

Figure 17: Control panels for moving the robot (highlighted in blue).

A gamepad is possibly the most intuitive way to move the robot. The fig. 18 shows the key assignment.
Pressing "Connect Gamepad" will connect iRC to a gamepad. If the connection is successful, an OK
sign will be displayed under the icon. The device must be of type "Joystick" or "Gamepad". For more
information about the connection, see the "LogMessages" tab (at the bottom of the window area).
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1. Change movement type

2. Change key assignment:

Switch between X, Y, Z and A, B, C in
Cartesian motion mode or A1, 2, 3 and
A4, 5, 6 in Axis motion mode.

3. Add Joint program instruction

4. Add Linear program instruction

Figure 18: Key assignment of the gamepad

Software buttons allow the selection of the motion mode. Three modes are available, each of which
allows the movement speed to be changed between 0 and 100% (Fig. 17):

• "Axis": Clicking on A1 to A6 moves the corresponding robot axis (if present). E1 - E3 moves the
external joints. This may be a linear or a rotational axis (19).

• "Base" (Cartesian mode) moves the robot in straight lines along the X, Y, and Z axes of the base
coordinate system.

• "Tool": (Cartesian mode) moves the robot in X, Y and Z of the current tool coordinate system.

Figure 19: The software buttons for "axis" movements. In both Cartesian modes, the buttons change
to X, Y, Z, A, B and C.

8.5 Starting robot programs

A robot program can be loaded and started as follows:

1. To load the program, click on the "Open" folder icon in the "Selected program" group of the
"Movement" tab and select a program, e.g. "testRobolink.xml".
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Figure 20: Loading a program (highlighted in blue).

2. Set the basic speed:

• Before starting an untested program, set the
speed to e.g. 20%.

• Be especially attentive during the first complete
program run and have the emergency stop key
ready.

3. Start the program:

• Click the "Execute" icon in the "Program Exe-
cution" button group of the "Motion" tab.

4. Pause or interrupt the program:

• After pressing the "Pause" icon, the robot can continue with the program by clicking the
"Run" icon again.

• After pressing the "Stop" icon, the program will start with the first command when the
"Run" icon is clicked again.

• The "Play" mode can be set to three different values:
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– Once (the program stops after a single cycle).
– Repeat (the program stops only by "Stop" or "Interrupt").
– Single step (this is useful for debugging a program).

8.6 Digital inputs and outputs

The status of the inputs and outputs can be monitored under "Inputs/Outputs". Both inputs and
outputs can be manually activated or deactivated:

• Outputs can be set manually when no program is running.
• Inputs can only be set in simulation when no robot is connected. So you can test the reaction

of programs to different inputs even without the corresponding hardware.

Figure 21: Input/output area of the iRC - igus Robot Control.

The configuration of the inputs and outputs is described in section ??.

8.7 Software interfaces

The robot controller provides various interfaces:
• PLC interface for control via the digital inputs and outputs. Especially for easy starting and

stopping of programs via a PLC or pushbutton.
• Modbus TCP interface for control via a PLC or PC.
• CRI Ethernet interface for control and configuration via a PLC or PC. This interface offers the

widest range of functions, but requires individual implementation.
• ROS interface for operating the robot via the Robot Operating System (www.ros.org).
• Interface for object detection cameras.
• Cloud interface for monitoring the robot state.

See section 11.5 for the configuration of these interfaces.

8.8 Updating the software

Updates of the iRCsoftware can be found at the following address: https://wiki.cpr-robots.co
m/index.php/IgusRobotControl-EN.

,
Create a backup because files can be overwritten during the update!
Rename your old iRC-Folder (z.B. C:\iRC-igusRobotControl) before starting the instal-
lation. This way you can go back to the old version.

The following may need to be copied from the previous installation:
• The created robot programs
• Changes in the project or in the robot configurations.
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9 Moving the Robot via Handheld Control Unit

To operate the robot without a Windows PC connected, the integrated computer is required. It runs
the TinyCtrl software as the robot control software. The integrated computer allows the robot arm to
be moved (via the handheld control unit) and robot programs to be played. To set up new programs,
it is connected via Ethernet to a Windows computer running iRC.
This section shows how to operate the robot with integrated computer and handheld control unit.
After all electrical connections to the robot have been made, the robot has been powered on, and the
emergency stop switch has been released, the faults must first be "reset" and then the robot must be
"activated".
When moving the robot, always keep one hand on the emergency stop switch to prevent it from hit-
ting an object unexpectedly, e.g. if it collides with the table.

9.1 Robot Reset and Enable

Figure 22: Press the "Enable" button in the top menu (top right) on the touchscreen display to go to
the Enable page.

Figure 23: Now press "Reset": The status changes to "MNE" (Motor Not Enabled).
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Figure 24: Press "Enable": The status changes to "NoError". "Not ref’d!" (in red) means "not refer-
enced".

9.2 Moving the robot with the 3-axis joystick

Once the robot is activated, the axes of the robot can be moved.

Figure 25: To do this, press the "Jog" key at the top of the display. 2. Press "Joints 1-2-3". Then move
and rotate the joystick. You can now move axes 1, 2 and 3. 3. Press "Joints 4-5-6". Now move axes 4
and 5 by moving and turning the joystick.

9.3 Referencing

To enable automatic program execution and linear movements ("XYZ Tool" / "XYZ Base")the robot
must be referenced. The type of reference movement depends on the robot or encoder type. In case
of doubt, each axis of the robot should first be moved (Fig. 25) close to the reference sensor of the axis
as described above.

Figure 26: Navigate to the Enable menu via the button "Enable" in the upper right corner.

©2022 igus® GmbH 32



9 MOVING THE ROBOT VIA HANDHELD CONTROL
UNIT

• Press the round "Reset" button followed by the round "Enable" button: the status changes to
"NoError". "Not refd!" (in red) means "not referenced".

• The robot must be in the status "NoError".
• Now press the button "Ref All" to reference all axes. The robot will now perform search move-

ments for each axis. A successfully referenced axis is indicated by the number "0" behind the
button "Ref XXX" changing to "1!.

• After referencing, the axes are in error state. This is necessary because the actual position has
changed during the referencing process.

Figure 27: Now press the round button "Reset" again, followed by the round button "Enable". The
robot is now referenced. Linear movements and programs can now be executed.

9.4 Starting and Stopping a Program

Figure 28: To do this, press the "Play" key at the top of the display and use the "prev" and "next" keys
to select a program written for your robot.

• Load the program with the button "Load".
• Let the program play once with "Single Play".
• "Cont. Play" plays the loaded program continuously.
• "Stop" stops the movement.
• The slider "Override" can be moved to the right to increase the speed of the movement or to the

left to decrease it.

9.5 Setting the Digital Outputs and reading the Digital Inputs

The digital outputs can be set by pressing the switches shown on the display (see Fig. 29). The boxes
below show the states of the digital inputs. The three buttons on the left side enable you to switch
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between several DIO modules.

Figure 29: If, for example, a gripper is connected to the DIO module, it can be activated or deactivated
by toggling the switches shown.

9.6 Displaying Status Information

Status information can be viewed by pressing the "Status" key in the upper left corner of the display.

Figure 30: The name of a program is displayed, e.g. while a program is running. The axis positions of
the axes 1-5 are displayed (A1-A5). The temperature of the stepper modules is also displayed. Due to
the different loads of the individual axes, different holding currents are applied, which lead to chang-
ing temperatures of the stepper modules.
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10 Programming a Robot with iRC

The iRC - igus Robot Control enables the creation of robot programs. The method of programming is
called "teach-in programming", which works as follows:

1. Move the robot manually to the position you want to record.

2. Record the position and define how this position should be reached (linear/joint movement).

3. Repeat these steps and add digital output commands or program flow commands in between
if needed.

The integrated editor is provided for creating and editing these programs.

10.1 Program Editor

Each command of the robot program consists of one line, e.g. "Joint" or "Wait". Only commands that
control the program flow are divided into several lines, e.g. "Loop" and "EndLoop". The program
editor is opened with the "Edit" button in the "Motion" tab ofiRC.

Figure 31: The program editor is opened by clicking "Edit".

The following window opens, here with a short program:

Figure 32: Program editor with a shord programm

The following sections show how to create a program with the program editor.

10.1.1 Changing the Command Sequence

To move a command, use the arrows on the right side of the command line. Alternatively, you can
click "Down" or "Up" from the command context menu (see Fig. 33).
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Figure 33: The context menu of a command

The program editor prevents invalid commands that would break the structure of the program. If
moving a command up or down is not possible, the corresponding buttons and menu items are
grayed out.

10.1.2 Touching Up Positions

Certain commands require position values as parameters. It is often desirable to use the current
position of the robot. Entering it by hand can take some time and is prone to errors. For such cases
you can use the command "Touch Up":

• Select the command and click "Touch Up!" from the "Edit" menu.
• Select the command and then press Ctrl+T.
• Open the context menu by right-clicking on the command and click on "Touch Up!" (see Fig.

33).
The program editor then replaces the position values in the command with the current position of
the robot.

10.1.3 Set Start Command

It is possible to execute programs command by command or to select a specific command as the
starting point of a program for test purposes. The command that will be executed first the next time
the program is started, or - if the program is currently running - the currently executed command is
marked by a dot in the program editor. The subprogram containing this command is also marked by
a dot in front of the program name.
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To select a specific command as the starting point for execution, click on "Start Here" in the context
menu (see Fig. 33).

10.2 Comments and Information within the Program

10.2.1 Information about the Program

The program editor inserts the pseudo command Start at the beginning of each program. It does
not represent a real command, but displays information about the current hardware, software and
kinematics. It is not possible to move or remove it.
When loading a program, this information is compared to avoid executing an incompatible program.

Figure 34: The Start line contains information about the current hardware.

10.2.2 Descriptions

Each command of a program contains a description. It should be used to describe to other users what
the command is for.

10.2.3 Comments

The Comment command can be used to insert plain descriptions into programs. It has no effect to
the robot during execution.
It can be found in the program editor in the menu item "Special" → "Comment".

10.3 Motion

10.3.1 Abort Conditions

Each motion command can be provided with a abort condition. It is a conditional expression that
follows the syntax described in section 10.5.1. During the execution of the motion command, the
instruction is continuously evaluated, and the moment it evaluates to "true", the robot stops moving.
It can be specified respectively under "abort condition" for each motion command.

10.3.2 Acceleration and Smoothing

To prevent abrupt movements an axis acceleration (percentage of maximum acceleration) and a
smoothing factor can be specified for each motion command. With a smoothing factor of 1-100%,
the motion instruction is smoothed with the following instruction, so that, for example, several linear
movements form smooth curves instead of stopping at each target point and starting again.
Smoothing is only possible with immediately following motion commands of the same type. E.g.
linear and circular movements can be smoothed with each other and axis movements with them-
selves. If a motion sequence is interrupted by a motion of a different type or by a logic instruction, the
smoothing is also interrupted and the robot stops briefly. The maximum number of commands that
can be smoothed is limited to 5-20, depending on the robot, in order to prevent calculation pauses in
the program sequence. In case of long paths this is shows by regular braking and restarting.
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�
If your application requires long uninterrupted paths you can increase the limit. Note
that this can lead to a short calculation pause before starting a very long paths. More
information can be found on our wiki under the keyword "LookAhead".

https://wiki.cpr-robots.com/index.php/Motion_Smo
othing

10.3.3 Joint Motion

The Joint command moves the robot to an (absolute) target position specified in axis coordinates.
The resulting movement of the TCP is usually a curve and not a straight line. The target position can
be specified in the following way (select the appropriate "source"):

• "Constant": The target position is a constant value for each axis.

• "Variable": The target position is taken from the position variable specified in "Variable".
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The movement speed is indicated by "speed". It is measured in percent of the maximum allowed
motion speed for the respective robot axes.
The joint command can be called in the program editor under the menu items "Action" → "AxisMo-
tion" and "Action" → "VariableMotion" → "AxisMotion".

10.3.4 Linear Motion

The Linear command moves the robot to an (absolute) target position specified in cartesian coordi-
nates. The resulting movement of the TCP follows a straight line. The target position can be specified
as follows (select the corresponding "source"):

• "Constant": The target position is a constant given by Cartesian coordinates x, y, z and Euler
angles A, B, C as well as the positions of the external axes if supported by the current robot
kinematics.

• "Variable": The target position is taken from the position variable specified in "Variable".

The movement speed is specified by "Speed" in mm/s. If it exceeds the maximum allowed movement
speed of the robot, it will cause a kinematic error during execution. The Linear command can be
called in the program editor under "Action" → "Linear Motion" and "Action" → "Variable Motion" →
"Linear Motion".
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10.3.5 Relative Motion

The Relative command allows to move the robot relative to its current position. It can be called from
the menu items under "Action" → "Relative Motion".
Under "Type" the following modes of relative movement can be selected:

• "Joint": The relative offset is specified in axis coordinates. The motion speed is specified by
"Speed" in percent of the maximum allowed motion speed for the respective robot axes.

• "Linear - Base": A linear motion is performed with an offset specified in Cartesian coordinates.
The coordinate system used for the offset is the robot coordinate system. The velocity is speci-
fied by "Velocity". It is measured in mm/s, if it exceeds the maximum allowed motion speed of
the robot, it will cause a kinematic error during execution.

• "Linear - Tool": A linear movement is performed with an offset specified in Cartesian coordi-
nates. The coordinate system used for the offset is tool coordinates. The speed of movement
is specified by "Speed". It is measured in mm/s. If it exceeds the maximum permissible move-
ment speed of the robot, this will result in a kinematic error during execution.

10.3.6 Circular Motion

The instruction "Circular Motion" enables movements along a full or partial circular path. It is com-
patible with linear movements, so that the transition from and to linear movements can be smoothed.

The circular path is defined by three points and optionally a target angle. The starting point is the po-
sition before the start of the circular command, usually the target position of the previous instruction.
Position 1 is a helper position on the circular path. Position 2 is the target position on the circular path.
If a target angle is specified, the movement can stop before reaching the points or go beyond them.
If angles greater than 360° are specified, the circle is moved several times, negative angles reverse the
direction of the motion.

,
The circular motion should not be the first motion instruction in the robot program. If
the program starts at an unexpected position, the circle may become larger or smaller
than expected.
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In addition, the target orientation of the tool and the target positions of the external axes can be
specified. These are linearly interpolated over the circular path.
The positions can be defined as constants via two position variables. In this case, the target orienta-
tion and the external axes must be specified in the variable for position 2 (target position).

�
Programming a curve path by Teach-In

1. Move the robot to the start position of the curve and add a linear instruction.

2. Move the robot to any position on the curve, e.g. half way. Add the circle instruc-
tion.

3. Move the robot to the end of the curve and click the "Set current position" button
in the "Position 2" line.

4. Optional: click the "Set Current Ori + Ext" button if the tool orientation or external
axes change during the curve path.

�
Programming a circular motion by calculating the circle points
For simple circular motions aligned with the axes of the coordinate system, it is rec-
ommended to calculate the coordinates of the center of the circle to calculate the start,
auxiliary and target positions and add or subtract the radius along the Cartesian axes.

10.3.7 Set Velocity

The instruction "Set Velocity" instructs an external axis to move at a constant velocity, for example for
a conveyor belt. The movement stops only when a movement of 0 units/s is assigned or the program
is stopped. This function only affects external axes configured for velocity mode (see section 11.1.4).

10.4 Gripper and Digital In-/Outputs

10.4.1 Digital Inputs

Digital inputs and global signals are available as reserved words in conditional statements (see section
10.5.1) For global signals these are GSig1, GSig2, etc. For digital inputs Din1, Din2, etc.. Depending
on the condition, they are evaluated as "true" or "false".

10.4.2 Digital Outputs

The Digital Output command is used to set digital outputs and global signals.
Under "Channel Type" it is specified whether a digital output or a global signal is to be set. Under
"Channel ID" the channel of the digital output or the global signal is specified, under "State" the
desired state after execution of the command is specified. The command is accessible in the program
editor under "Action" → "Digital output".

10.4.3 Opening/Closing the Gripper

The Gripper command allows controlling the robot’s gripper. It is accessible in the program editor
through the menu item "Action" → "Gripper".
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Under "Opening" you can set the desired opening, measured in percent. A value of 0% stands for a
completely closed gripper, 100% for a completely opened gripper. For grippers that can only be either
fully opened or fully closed, the threshold between these states is 50%.

10.5 Program Flow

10.5.1 Conditions

Conditions can be used in if-then-else statements, loops, and as abort conditions in motion state-
ments. Conditions can be combinations of digital inputs, global signals, Boolean operations, and
comparisons. Examples:

DIn23 True if digital input 23 is set.

DIn23 AND !DIn27 True if digital input 23 is set and 27 is not set.

modelclass = 31 True if the variable "modelclass" is 31

mempos.x > 350.0 True if the x component of the position variable "mempos" is greater
than 350.

The syntax of conditional statements is defined by the following EBNF definition:

Expression : = ["!"] <Boolean> <BooleanOperator> <Boolean> ...

Boolean : = <BooleanConstant> | <Expression> | "(" <Expression> ")" | Com-
pExpression | "(" <CompExpression> ")" | <DigitalInputs> | "(" <Dig-
italInputs> ")"

BooleanOperator : = "And" | "Or"

BooleanConstant : = "True" | "False"

Digital Inputs : = <ChannelType> <ChannelId>

ChannelType : = "Din" | "GSig"

Channelld : = Integer value

CompExpression : = <CompValue> <CompOperator> <CompValue>

CompValue : = <Variable> | <Number>

Variable : = <Numbervariable> | < PositionComponent>

Numbervariable : = Name of a number variable

Positions component : = <Position variable> "." <Component>

PositionVariable : = Name of a position variable

Component : = "x" | "y" | "z" | "A" | "B" | "C" | "A1" | "A2" | "A3" | "A4" | "A5" | "A6" |
"E1" | "E2" | "E3"

Number : = Integer or floating point number

CompOperator : = "=" | ">" | "<" | ">=" | "<="

10.5.2 Stop

The command "Stop" stopps the program execution.
It is available through the menu item "Flow" → "Stop".
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10.5.3 Pause

The Pause command pauses the execution of the program. The execution can be resumed later by
the user.

10.5.4 Wait

The Wait command instructs the robot to wait until a specified amount of time has passed or a condi-
tion is met. It is accessible via the menu items under "Program Flow" → "Wait" in the program editor
of the iRC.
The different modes can be selected under "Type":

• "Timeout": The time specified in "Timeout" will be waited.
• "Condition": Waits until the condition specified in "Expression" evaluates to "true".

10.5.5 If-then-else

The If command branches the execution of the program depending on the value of a conditional
expression. It is accessible through the "Flow" → "If...then...else" menu item in the iRC program
editor.
The specified condition must conform to the syntax described in section 10.5.1. The statements be-
tween "If" and "Else" will be executed if the condition evaluates to true. Otherwise the statements
between "Else" and "EndIf" will be executed.

Figure 35: The If statement branches the program flow.

10.5.6 Loops

The Loop command allows the definition of execution loops. Under "Type" you can choose between
the following loop types:

• "condition": The loop is repeated until the specified condition evaluates to "true". It must
conform to the syntax described in section 10.5.1.

• "counter": The loop will repeat the number of times specified in "repeats".
The loop command is accessible through the menu items "Flow" → "Loop".

10.5.7 Matrices / Palettizing

The matrix instructions calculate positions aligned to a grid, e.g. as gripping or depositing position
for palletizing tasks. Figure 36 shows a motion pattern that can be executed by using the raster in-
structions.
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Figure 36: The matrix movement is from point A to B, then offset in direction C
.

iRC provides two approaches to program this:

Statement type Description

Matrix loop Executes a statement block for each raster position.

Matrix definition and raster query Allows to calculate arbitrary raster positions based on an in-
dex variable.

The matrix loop is suitable for simple use cases where the positions are processed strictly in their
order. The loop starts with the first position and is left after the last position. The matrix definition and
query is more flexible, several grids can be used at the same time and the positions can be retrieved
in any order, but the index variable must be counted by additional logic. This allows e.g. to start with
a partially filled palette or to skip positions.
The matrix loop can be added via the menu item "Program flow" → "Loop" → "Raster". Matrix defi-
nition and matrix query are located in the menu "Special commands" → "Raster".
The position variables specified as "Point A", "Point B" and "Point C" define the corners of the area
covered by the raster loop (see figure 36). The number of steps to be taken is specified by "counter X"
(from A to B) and "counter Y" (from A to C). For example, in the figure above, X=4 and Y=3.
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Figure 37: Definition of a matrix loop

The block between "Matrix" and "Matrix End" is executed for each step. The position variable "Tar-
getPosition" contains the position of the current target point for the respective step. Row and column
of the current step are stored in the number variables given to "Counter X" and "Counter Y" respec-
tively.
The matrix definition and query instructions use the same parameters: The dimensions and positions
are specified in the raster definition, and the index and output variables are specified in the raster
query. Different rasters are identified by a name.

Figure 38: Usage of matrix definition and matrix query commands. The definition of variables is
omitted.

10.5.8 Subprograms

Subprograms can be executed using the Sub command.
The path to the subroutine file is specified under "Filename". It is relative to the subfolder "Pro-
grams" of the iRC folder "Data". The command can be invoked from the menu item "Programflow"
→ "Subprogram".

10.6 Variables and Variable Access

Programs for iRC and TinyCtrl support two types of variables:
• Number variables: These can be used to store integer or floating point numbers.
• position variables: These can be used to store cartesian and joint positions. Whether such a

variable is interpreted as cartesian or joint depends on the context.
The cartesian components x, y, z are in mm, the euler angles A, B, C are in degrees. The joint
values are measured in mm or degrees depending on the type of axis.

©2022 igus® GmbH 45



10 PROGRAMMING A ROBOT WITH IRC

Figure 39: Definition of a number variable.

Figure 40: Definition of a position variable.

10.6.1 User-defined Variables

It is possible to define variables with the Store command, which is accessible in the program editor
through the menu items under "Special" → "Variable definition".
Three types of store operations can be selected:

• "Current position":
A position variable is initialized with the cartesian and axis position of the robot when the com-
mand is executed.

• "NumberConstant":
A number variable is initialized with the constant specified in "value" (see 39).

• "PositionConstant":
A position variable is initialized with the constants specified in "Cartesian Position", "Joint Po-
sition" and "External Joints" (see fig. 40). Depending on the kinematic model of the current
robot, certain axes may not be available.

The name of the variable can be set under "Variable". If a variable with the same name is already
defined, its value and type will be overwritten. All variables are global, i.e. they are also accessible
from subroutines.

10.6.2 System Variables

The following predefined variables are available without having to define them:
• #position: The current position of the robot.

©2022 igus® GmbH 46



10 PROGRAMMING A ROBOT WITH IRC

• #programrunning: 1 if the robot program is running, otherwise 0.
• #logicprogramrunning: 1 if the logic program is running, 0 otherwise.

Note that the system controls the values of predefined variables - they cannot be changed by the
program. The names of predefined variables always start with "#"

10.6.3 Accessing Elements

Position variables contain the following elements:
• Position: x, y, z
• Orientation: a, b, c
• Joint positions: a1, a2, a3, a4, a5, a6, e1, e2, e3

The elements are accessed by appending them with a dot, e.g. "myvariable.x" or "myvariable.a3".

10.6.4 Calculating with Variables

Calculations with variables can be performed using the Math command, which is accessible in the
program editor via the menu item "Special" → "Variable operation".
"First operand" defines the first operand of the operation to be executed. It is also used to store the
result.
"Second operand" defines the second operand of the operation. It can contain numeric constants,
names of number variables or components of position variables.
The following operations are supported and can be selected under "Operation":

• Assignment: The first operand is set to the value of the second operand.
• addition: The first operand increased by the value of the second operand.
• subtraction: The first operand is decreased by the value of the second operand.
• Multiplication: The first operand multiplied by the value of the second operand.
• Division: The first operand divided by the value of the second operand.
• Modulus: The remainder of the division of the first operand by the second operand is stored in

the first operand.
The following combinations of operands and operators are allowed (number here also means position
components):

Assignment Plus Minus Mult. Division Modulus

Both are number x x x x x x

Both are position x x x

Op 1 is position, Op 2 is num-
ber

x x x

Op 1 is Number, Op 2 is posi-
tion

10.6.5 Observing Variables

You can observe the current values of all defined variables in iRC in the "Programs and Variables" tab
in the status area.

10.7 Camera

The camera instruction allows object information to be retrieved from an object detection camera.
The information includes grab position and orientation, as well as object type and detection state.
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Figure 41: The values of the variables are displayed in the info area.

To use a camera, it must be defined and calibrated in the configuration area (see section 11.5.5). The
program instruction can be added via the menu item "Special Commands" → "Camera".

Figure 42: Camera command in the program editor.

Under Type the type of camera must be selected, under Name the name defined in the configuration
must be entered. The output variables for target position and model class must have been declared
beforehand by store command. The target position contains the position and orientation of the object
in the coordinate system of the robot, while the model class contains an identification number for the
detected object type. If no object was detected the value of the model class is "-1".

ð
The camera command does not wait if no object has been detected. Use an If statement
or a condition loop to check whether the camera has actually detected an object!

ð
The orientation of the object can cause a slow linear movement of the robot!
If the rotation of the tool axis takes longer than the movement of the tool to the object
position, then the movement is slowed down accordingly. This happens even if no tool
axis is installed. If the object orientation is not relevant or no tool axis is installed, this
can be avoided as follows:

1. Determine the orientation of the robot before moving to the object position, for
example by defining a new position variable there and initializing it with the cur-
rent position. If no tool axis is installed you can use the constant orientation val-
ues from the information area of iRC.

2. Create three assignment statements (Math statement) and overwrite the A, B and
C components of the target position with the determined values.
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11 Configuration

The behavior of the robot can be changed via the configuration. The most important parameters can
be found in the configuration area of iRC - igus Robot Control, which can be opened via "File" (see
Fig. 43). Settings concerning the project can be found under "Project configuration", cross-project
settings under "Robot configuration". The interfaces can also be configured on a project-by-project
basis via "interface configuration".

Figure 43: The project configuration area.

More specific settings can be made via the project, robot, and tool configuration files. The settings of
the axis modules can be accessed and changed via "Get/Set Amp Configuration" (see section 11.6).

,
Change the configuration files only if you know what you are doing! Test the robot care-
fully, because it could move unexpectedly fast or collide! Changes of the firmware pa-
rameters can lead to overheating of the motors or the electronics!

If you use a robot with integrated controller (TinyCtrl), the changes must also be made there. When
making changes via the configuration area, connect the robot first. Clicking on "Apply" or "Save
Project" will automatically synchronize the changes with the robot controller. Changes to the config-
uration files must be transferred manually, use the "Access Configuration" area.

ð
Some changes to the integrated robot controller are only applied after a restart. Wait at
least 20 seconds after the transfer and restart the robot.
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11.1 Project Configuration

11.1.1 Program

Here you can set the robot and logic program, the movement speed (as a percentage of the maximum
speed), the replay mode and the reaction to program errors.

11.1.2 Tool

The mounted tool can be defined here. Changing the tool requires reloading the project or restarting
the integrated control.
New tools can be defined as configuration file in the directory "Data/Tools". New and changed tools
are not automatically synchronized with the integrated control. To commit changes, open the "File"
→ "Tool Configuration" area, click the "Add" button in the "Tool Configuration" area and select the
new tool configuration file.

11.1.3 Virtual Box

The virtual box defines an area that the tool center of the robot must not leave. If the limits are ex-
ceeded, the movement stops.

11.1.4 Additional Axes

The robot controller supports up to 3 additional axes (also called "external axis" in iRC). These can be
installed in cabinet similar to the robot axes and configured via the configuration area of iRC.
When installing the axis modules, the CAN ID must be specified. For Commonplace Robotics motor
modules this is done via the rotary switch at the top of the module, table 8 describes the default
assignment. CAN IDs not yet assigned can be used for additional axes. For CANopen controllers, the
IDs can be selected arbitrarily in the range 1-128.

Switch position Robot axis CAN-ID (dec.) CAN-ID (hex.)

0 1 16 0x10

1 24 0x18

2 2 32 0x20

3 40 0x28

4 3 48 0x30

5 56 0x38

6 4 64 0x40

7 72 0x48

8 5 80 0x50

9 6 88 0x58

Table 8: Standard CAN ID switch settings on CPR motor modules

After switching on the controller and connecting iRC, the number of additional axes can be specified
in the configuration area (File → Project Configuration → External Axes). Then a parameter set with
the following entries appears for each axis:
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Motion Mode Defines whether the axis operates in position or velocity mode. In
velocity mode, a constant velocity can be set in the robot program,
position commands will be ignored.

CAN-ID CAN-ID of the axis module

Encoder steps per unit Ratio factor from mm or degrees to encoder step (calculation see
below)

Position min/max Motion limits

Speed max Maximum speed

Acceleration Acceleration

Acceleration increase Acceleration increase

,
The velocity in velocity mode is not precise. Test the configuration with low override
and adjust the parameter if necessary.

ð
After changing the external axes, the project must be saved and reloaded. A robot with
integrated control must be restarted after at least 30s.

The calculation formula 1 shows the calculation of the encoder steps per unit from the number of
encoder steps, the gear ratio and the travelled distance of a full output revolution in any unit. Example
2 shows the calculation of a rotation axis, as it is installed for example as axis 4 of a RL-DP-5. Example
3 shows the calculation of a linear axis without gear.

4 ·encoder steps · g ear r ati o

di st ance
= encoder stepsper uni t (1)

4 ·500 ·38

360◦ = 211,111 (2)

4 ·500 ·1

70mm
= 28,57 (3)

Table 10 contains some examples of linear and rotational axes.

Type of Axis Reduction Gear Scale

igus ZLW-1040 70 28.471

igus GRW-0630 45 44.444

igus SAW-1040 2 1000.00

igus ZLW-20200 144 41.667

igus RL-D-50 48 266.67

igus RL-D-30 50 277.78

igus RL-D-20 38 211.11

Table 10: Example values of various linear and rotary axes
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11.2 Robot Configuration

The robot configuration contains robot type specific parameters. Changes therefore affect all projects
of the respective type.
The axis lengths of gantry robots can be changed in the configuration area (File → Robot configu-
ration → Gantry). Depending on the number and configuration of axes, different parameters are
available for this purpose.

Axis length Length of the axis in the 3D simulation

Motion max Usable length of the axis

ð
After changing the axis lengths, the robot configuration must be saved and reloaded. A
robot with integrated control must be restarted after at least 30s.

11.3 In-/Outputs

The controller supports different types of inputs and outputs, which can be configured in the project
configuration area under "Inputs/Outputs":

• Basic inputs/outputs: These inputs and outputs with numbers from 1-20 are only relevant for
Mover series robots. They are ignored for DIN-Rail controllers.

• DIN-Rail Inputs/Outputs: Up to 3 input/output modules can be connected via DIN-Rail similar
to the motor modules.

• Global signals: These are virtual inputs/outputs. They can be set and read via robot programs,
the CRI interface or the Modbus interface. Up to 100 global signals can be used.

11.3.1 Electrical Integration

The easiest way to connect a programmable logic controller (PLC) is via digital inputs and outputs.
Each robot controller is supplied with a DIO module. This provides 7 inputs and 7 outputs. If addi-
tional inputs and outputs are required, up to two additional DIO modules can be integrated. In total,
up to 3 DIO modules can be controlled.
The outputs are controlled by solid state relays and can switch up to 500 mA. This value must not be
exceeded during the switching process (e.g. by charging currents of capacitors) to prevent damage to
the relays.
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Figure 44: Internal structure of a DIO module

The inputs and outputs are galvanically isolated from the robot controller. A power supply (labeled
"IO Supply" in the picture above) must be connected. The integrated 24 V supply can also be used.
To add DIN-Rail modules, first install them in the control cabinet and set the CAN IDs according to
the tables 12.

11.3.2 Software-Configuration

Turn on the controller and connect iRC. In the configuration area, enter the number of input/output
modules. Save the configuration and restart the controller and iRC after 30 seconds. If other CAN IDs
are required, you can enter them manually in the project configuration file.

Switch position Module number CAN-ID (dec.) CAN-ID (hex.)

0 1 112 0x70

1 120 0x78

2 2 128 0x80

3 136 0x88

4 3 144 0x90

5 152 0x98

6 160 0xA0

7 168 0xA8

8 176 0xB0

9 184 0xB8

Table 12: Standard CAN ID switch settings on CPR DIO modules
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Switch position Modul number CAN-ID (dec.) CAN-ID (hex.)

0 1 112 0x70

1 2 113 0x71

2 3 114 0x72

Table 13: Standard CAN ID switch settings on CANopen DIO modules

ð
If more modules are defined than installed, the controller will report a module error
and will not be usable until the error has been corrected.

You can enter a descriptive name for each input and output. This is only relevant for the display, but
not as a name in program conditions. The reset state indicates which state an output changes to on
reset, the error state is assumed if an error occurs.

11.3.3 Connecting sensors and buttons

• Pin 1 (GND) of the D-in 1 connector must be connected to the negative terminal (-) of the sensor
power supply.

• The sensor signal (positive) must be connected to an input pin: D-in 1 connector pins 2-4 or
D-in 2 connector pins 1-4.

• The positive side of the sensor (+) must be connected to the power supply of the sensor.
• The status of the inputs can be monitored in the "Input/Output" tab at the bottom of iRC.
• Inputs can be queried and reacted to in a robot program, e.g. in an if-then-else command....

11.3.4 Connect actors

• Pin 1 (supply voltage) of the D-out 1 connector must be connected to a power supply (e.g. 24V).
• The actuator (relay etc.) is then supplied with power via a free pin of the D-out connectors

(D-out 1 pin 2-4 and D-out 2 pin 1-4).
• You can set the outputs manually in the "Input / Output" tab at the bottom of iRC.
• In a robot program you can set the state of the outputs with the digital-out command in iRC.
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Figure 45: Example: Connection of a sensor and an motor

11.4 Motor Brake

To prevent the axes from falling, electromagnetic brakes can be used, which release the axis by apply-
ing a voltage. Without voltage they fall into the braking state by springs.

11.4.1 Electrical Integration

ð
The standard brakes integrated in the motors work under 24V. However, please refer to
the documentation of the motors.

To release the brakes two conditions have to be verified:
• The Emergency Stop has to be released
• The control has to send the brake release signal

The electrical conversion takes place via two relays connected in series. In addition, the emergency
stop status can be read in as a digital input in order to handle a very fast triggering/release of the
emergency stop.
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Figure 46: Connection of brake relays and brake

For further details please refer to the circuit diagrams that can be found on the Wiki pages.

11.4.2 Software Configuration

In File/RobotConfiguration area of the software a digital output for the motor brake can be defined.
The output is switched active when the motors are released, so that it can control a relay and release
the brakes via it. In the event of an error, the output is deactivated.
The parameter "Release delay" specifies how long the brake remains in the braking state after the
motors have been activated. This allows the motors to build up a holding torque before they have to
carry the axle load. The default value is 500ms.
The emergency stop monitoring allows the coupling of a digital input with the 24V emergency stop
relay to detect a voltage loss faster (the axis modules detect a voltage loss partly delayed due to the
installed capacitors - this can lead to problems if the emergency stop is released very quickly). The
brakes are activated faster and the digital outputs are reset to their error states.

ð
After changing the brake configuration, the robot configuration must be saved and
reloaded. A robot with integrated control must be restarted after at least 30s.
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11.5 Interfaces

For communication with and control by other software and devices iRC offers a PLC interface, the
CRI Ethernet interface and an interface for connecting ifm O2D cameras.

11.5.1 PLC Interface

The PLC interface enables the execution of basic functions and the signaling of states by means of
digital inputs and outputs. In addition to control by a PLC, this interface also enables operation by
hardware pushbuttons.
The PLC interface requires unused digital inputs and outputs. It reacts to rising edges at inputs.
The following input functions are supported:

Enable Executes Reset and Enable

Request reference Starts the referencing of all axes

Play Starts the execution of the loaded program if no program is running, con-
tinues a paused program or stops the execution of a running program

Pause Pauses a running program or continues a paused program

Alt Start One-button control: Executes the following functions in succession when
the button is pressed several times: Reset, Activate, Reference (if not yet
done), Start program

Alt Stop One-button control: Executes the following functions in succession when
the button is pressed several times: Pause, Stop, Reset

Shutdown Shuts down the control computer

Start Platform Mission Starts the mission of the mobile platform

Add joint command Add-Axis statement to the current position in the program editor

Add linear command Add-Linear statement to the current position in the program editor

ð
Add-Joint and Add-Linear can only be used if iRC is connected to the robot.

The following output functions are supported:

No fault Output is active when the robot is in fault-free state

Fault Output is active when the robot is in fault state

Robot is referenced Output is active when all axes are referenced

Program running Output is active when a program is running

No program running Output is active when no program is running

Platform mission running The mobile platform is executing a mission

The configuration of the PLC interface is done via the configuration area in iRC (File → Configure
Interfaces → PLC interface). To configure a robot with integrated control it must be connected. The
field "Active" activates the interface, "Automatically connect" causes iRC to try to connect to the robot
automatically. The number fields to the inputs and outputs correspond to the numbers of the digital
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inputs/outputs. To disable individual functions, select a number that is not present on any hardware
module, e.g. "1".

11.5.2 Program Selection via Digital Inputs

Robot programs can be loaded and started via digital inputs or global signals. This is useful, for exam-
ple, if a program is to be selected from a given selection via pushbuttons or the CRI-GSig instruction.
The configuration for this can be found in the configuration area of the PLC interface in the section
"Program Trigger".
The following parameters can be specified for each program trigger:

Active Enables the program trigger

Type Type of input signal: digital input (DIn) or global signal (GSig)

Number Number of the input. E.g. 21 for DIn21 or GSig21

Program Type Robot program or platform mission

Program File Program or mission file. Must be in the programs or missions directory

11.5.3 Modbus

With the Modbus TCP interface, for example, PLCs can send data and instructions to the robot con-
troller and receive status information. For more information on the use and licensing of this interface,
see section 12.
The Modbus interface can be enabled through the interface configuration. Unlike the other configu-
ration parameters, these settings are not mirrored with the connected system to prevent the configu-
ration of the integrated controller and the control software on the Windows PC from colliding. For this
reason, if a robot controller is connected, the parameters displayed refer to it; if none is connected,
they refer to the PC software.
The following parameters can be configured:

Enabled activates the Modbus server

Port TCP port of the Modbus server

Max connections Maximum number of simultaneous connections to the server (inte-
grated control only)

11.5.4 CRI Interface

The CRI interface allows you to send complex instructions and retrieve information and settings via
the Ethernet interface using TCP/IP. iRC uses this interface to connect to robots with integrated con-
trol or other instances of iRC. By default, this interface is disabled in iRC.
Documentation of all supported instructions as well as sample code can be found at the following
link:

https://wiki.cpr-robots.com/index.php/CRI_Ethernet_Interface

To enable the interface in iRC open the configuration area (File → Configure Interfaces → CRI inter-
face). The "Start" button starts the CRI server, "Stop" stops it. The status field shows the bound IP
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address and port, and the number of connected clients. If a specific IP address is to be used, it can be
entered in the field below.

11.5.5 Camera Interface

The camera interface enables the use of object recognition and video cameras. Object recognition
cameras detect the position and class of objects and transmit these to the controller, optionally with a
video image. From the object positions of the camera, the controller calculates positions in the robot
coordinate system. Video cameras only provide images and can therefore only be used to observe the
work area, but not for object recognition.
Currently, the robot controller supports the following camera types:

• ifm O2D object detection cameras and cameras that can emulate their TCP/IP protocol.
• USB video cameras (e.g. webcams and industrial cameras supporting USB video class (UVC))

The cameras can be added to the robot controller via the "Cameras" section of the interface configu-
ration. There, a distinction is made between cameras on the PC and the integrated controller. If the
robot is controlled by an integrated controller, then the cameras must be configured there.
The following sections describe the configuration of both camera types.

�
Not every integrated controller supports USB video cameras. The section below ex-
plains compatibility.

Camera Interface for Object Recognition

For object recognition only the ifm O2D200 series cameras are currently supported as well as cameras
that can emulate their TCP/IP protocol (as described here: https://wiki.cpr-robots.com/inde
x.php/Remote_Variable_Access#Protocol).
To use a camera it must be configured in the configuration area (File → Configure Interfaces → Cam-
eras). If the camera is to be configured on a robot with integrated controller, iRC must be connected
to it.
Select the type of camera ("IFM O2D") and click "Add Camera" to add a camera. The "General" area
contains the following parameters:

Enabled Enables or disables the camera. In the deactivated state, the values from the
simulation area are used (only iRC)

Image enabled If this field is activated, the robot controller regularly requests the current
camera image if the camera does not send it automatically. Supported are
images in the format "Windows Bitmap".

Name Name of the camera in the robot program

Description Optional description

IP address IP address of the camera

Port Port number of the camera

The entries in the geometry area control the processing of the positions provided by the camera (pixel
position of the camera image) to positions relative to the robot (see fig. 47):
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Figure 47: Measuring the camera position and orientation.

Scaling Scales the pixel position

Origin Position of the camera in the robot coordinate system

Look Viewing direction of the camera. A downward pointing camera has Z=-1

Up X Direction of the camera in the robot coordinate system

Z Distance Distance of the objects from the camera

�
For step-by-step instructions and tips on parameterization, please refer to our Wiki ar-
ticle:

https://wiki.cpr-robots.com/index.php/2D_Camer
a_Integration

The simulation section enables the simulation of the camera. This function is not available in the
integrated control.
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SimX, SimY Object position in pixels (0-640 and 0-480 respectively)

SimA Orientation in degrees

Model class Class of detected object, the value -1 means no object is recognized.

After configuration, the detected and
calculated values can be observed in the
status area. Images received from the
camera are displayed here.

Figure 48: Camera status area

Camera Interface for USB Video

USB video class (UVC) cameras can be used to observe the work area, for example webcams or in-
dustrial USB video cameras. The robot controller forwards the received images via the following in-
terfaces:

• CRI interface: The image is transmitted via the Ethernet interface to iRC and can be observed
there in the camera status area (see fig. 48).

• Cloud interface: When this is enabled and the camera is assigned the image is transmitted to
the RobotDimension cloud. The image can be monitored via the website (see section 11.5.7).

�
Compatibility:
The USB camera interface is only supported by integrated controllers based on the
Raspberry Pi. Older robot controllers controlled by a Phytec module do not support
USB cameras. The Windows software iRC does not support this camera interface ei-
ther, here USB cameras can be assigned directly in the cloud configuration area (see
section 11.5.7).

Connect the camera to one of the USB ports on the control module. In the camera configuration area
of iRC, add a USB type camera, give it a unique name and select the device number. You may need to
try different numbers in the range 0-10. The camera status area displays the connection status and,
if successful, the camera image. To transfer the image to the cloud, the camera must be configured
using the specified name in the cloud configuration area.

�
The camera number may change after restarting the controller or if another camera
has been connected. Restart the controller after configuration and correct the number
if necessary.

11.5.6 Network

The WiFi interface of the integrated controller can be activated and configured via the network config-
uration area. When the configuration area is opened, it is automatically checked whether the function
is supported. Phytec-based robot controllers generally do not support WiFi, newer controllers may
require a software update.
To change the configuration, the "Change" box must first be set. Then the mode can be selected:
"Disabled" disables the WiFi interface, "Access Point" opens a new WiFi network, "Infrastructure"
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lets the controller connect to an existing network. For an internet connection the latter is needed.
Then specify the parameters (depending on the mode, only the required ones are displayed):

SSID WiFi network name

Password WiFi password

IP address WiFi IP address of the controller. You can use this to connect to the robot. Is
optional in infrastructure mode, in which case it is assigned automatically.

Router IP address The IP address of the router in infrastructure mode, which provides the
route to the Internet. This entry is optional, if empty it is assigned auto-
matically.

The settings are usually applied immediately. Only when activating and deactivating the interface is it
necessary to restart the controller. When the interface is activated, it may be blocked after the restart
(similar to the airplane mode of mobile devices), in which case the configuration area shows a button
that will enable the interface.

11.5.7 Cloud

The cloud interface enables remote monitoring of the robot via RobotDimension. After activation
and login, the robot sends basic status information and camera images to the online service, from
whose website they can be retrieved. Controlling the robot via the Internet is not possible.

https://www.robotdimension.com

To use the cloud interface, a controller with Internet connection is required, for example an integrated
controller as described in section 11.5.6 or a PC with iRC, which is connected to a robot. In addition,
an account with RobotDimension is required, there a separate robot password must be set in addition
to the online password.
The cloud interface can be activated via the interface configuration in iRC. To enter the user informa-
tion, the field "Set Credentials" must be set.

User name login email address at RobotDimension

Password Robot password at RobotDimension

Client ID To distinguish multiple robots, if empty it will be randomly generated

The following data can optionally be sent to the cloud, it is for information only:

Robot name Identifying name of the robot

Robot owner Owner or person in charge of the robot

The images from up to two cameras can be sent to the cloud, for example to monitor the work area
and the environment. For a robot connected to the cloud via iRC, USB cameras connected to the
PC can be selected via the device number. If successful, a preview image is displayed. In the case
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of a robot with an integrated controller that connects to the cloud independently, USB and object
detection cameras can be configured in the camera configuration area and assigned here for image
transmission based on the name specified there.

11.5.8 Secure Shell Access

The control computer can be accessed e.g. for maintenance purposes via secure shell (ssh) (port 22),
e.g. to change project files or robot files manually. Username is "robot", password is "robot".

Illustrated instructions are available here:

https://wiki.cpr-robots.com/index.php/FTP_and_p
utty_Access

,
The Windows software iRC and the Embedded control software TinyCtrl use configu-
ration files. If changes are made manually (e.g. in a text editor) to the configuration
files on one of these systems, they must also be made on the other side. Otherwise the
controllers do not behave identically, collisions may occur!

Via the software Putty one can connect to the Linux board and work on a command line. This way
you can for example view the live outputs of the robot controller.
For the work on the command line Linux knowledge is necessary!

1. Download and run Putty.exe.

https://putty.org

2. Establish the Ethernet connection. Connect LAN cable to Windows PC and integrated com-
puter. The Windows network adapter must have IP address 192.168.3.1, subnet 255.255.255.0.
The integrated computer has IP 192.168.3.11 in subnet 255.255.255.0.

3. Start Putty and in the field "Host Name (or IP address)" enter the address of the integrated
computer: 192.168.3.11. Set "Port" to 22 and "Connection Type" to SSH. Then click on "Open".
A window will open. You may be asked if this computer can be trusted.

4. Login: robot

5. Password: robot

6. After login you are in the home directory of the "robot" user, which contains the TinyCtrl direc-
tory, whose content is similar to the iRC directory in Windows.

7. Robot files are located in ~/TinyCtrl/Data/Robots/<robot type>/<robot model>/<robot model>.xml.

8. The project file where the robot file is referenced are located in ~/TinyCtrl/Data/Projects/Em-
beddedCtrl.prj
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9. As editor nano, vim and vi are preinstalled.

10. After editing and saving the file, the controller must be restarted for changes to take effect.

11. To display the TinyCtrl log output live in the terminal (this is especially useful after changes in
the files), TinyCtrl must first be terminated: killall TinyCtrl

12. Then navigate to the directory ~/TinyCtrl and start ./TinyCtrl

13. The process can be terminated by pressing Ctrl+C.

14. After restarting the controller TinyCtrl starts automatically.

11.5.9 SFTP Access

The "Secure Shell File Transfer Protocol" (SFTP) access works in principle like the SSH access in the
section above, but allows the user to make changes to the project and robot files for maintenance
purposes without having to use a terminal.

Illustrated instructions are available here:

https://wiki.cpr-robots.com/index.php/FTP_and_p
utty_Access

,
The Windows software iRC and the embedded control software TinyCtrl use configu-
ration files. If changes are made manually (e.g. in a text editor) to the configuration
files on one of these systems, they must also be made on the other side. Otherwise the
controllers do not behave identically, collisions may occur!

SFTP is the SSH File Transfer Protocol. It can be used to transfer or adjust files from one computer to
another. FileZilla is a free FTP program.

1. Download and install FileZilla Client:

https://filezilla-project.org

2. Establish Ethernet connection. Connect LAN cable to Windows PC and integrated computer.
The Windows network adapter must have IP address 192.168.3.1, subnet 255.255.255.0. The
integrated computer has IP 192.168.3.11 in subnet 255.255.255.0.

3. Start FileZilla and specify the following:

• Host: 192.168.3.11
• Username: robot
• Password: robot
• Port: 22

Then click Quickconnect.
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4. The SFTP connection to the robot is now established:

• in the left window the local directory structure of the Windows PC is shown.
• The right window of FileZilla shows the directory structure on the Linux computer.
• The embedded equivalent of the iRC control software is called TinyCtrl. It is located in the

~/TinyCtrl folder.
• The directory structure inside the TinyCtrl folder strongly resembles that of iRC.

Adjusting parameters in a robot or project file

1. To do this, navigate to the appropriate folder and copy the file to a local folder using "Drag and
Drop".

2. Here you can edit the file with a standard text editor like Windows Notepad. (Notepad++ is a
better text editor https://notepad-plus-plus.org/).

3. Once all changes are saved in the local file, it can be copied to the destination folder on the
Linux PC by "drag and drop".

4. This will overwrite the file in the destination folder "Overwrite"

5. To let the configuration change take effect, the controller must be restarted.

11.5.10 Uninterruptible power supply (UPS)

Under certain conditions it may be desirable to connect a low voltage supply. The "apcupsd" daemon
is integrated on the integrated control computer, which allows the controller to shut down safely in
the event of a power failure and possibly a subsequent low battery level. A "APC Back-UPS Pro 1500"
is supported. The UPS is connected to the control computer via USB cable. The robot controller is
connected to the UPS via Schuko plug. The UPS is connected to the mains. No further configuration
is necessary, because the "apcupsd" is preconfigured. If it is necessary to change the configuration,
e.g. if another UPS compatible with apcupsd is connected, we refer to the apcupsd documentation:

http://www.apcupsd.org

11.6 Configuration of the motor controls

For the fine adjustment of the movement and the referencing, each axis module contains its own con-
figuration set. This can be retrieved and modified via the buttons "File" → "Get Amp Configuration"
or "Set Amp Configuration". After downloading, the configuration file is created in the installation
directory of iRC under Data\Backup.
A detailed description of the parameters can be found at the following link:

https://wiki.cpr-robots.com/index.php/Firmware_P
arameter_Configuration

,
Change the firmware parameters only if you know what you are doing. Test the robot at
slow speed and watch the temperatures of the electronic modules and motors.
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11.7 Advanced configuration

Things beyond that can be changed in the project and robot files.
The access to the configuration files of a robot with integrated controller is possible via "File" → "Ac-
cess Remote Configuration".

,
Do not change the configuration files unless you know what you are doing. Test the
robot at slow speed, as it may behave unexpectedly, move too fast or collide if the con-
figuration is incorrect.
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12 Modbus

The Modbus TCP protocol enables the control and retrieval of configuration and status information
from TinyCtrl-based integrated robot controllers. This allows robots to be easily controlled by pro-
grammable logic controllers (PLCs) and integrated into processes with other devices.

12.1 Licensing

The use of the Modbus functions requires a license. The functions can be used freely for test pur-
poses for 30 minutes, after which another test period can be started by restarting the controller. The
installation of a license file is described in the iRC documentation. Further information is available at

https://shop.cpr-robots.com/?product=modbus-tcp-
ip-schnittstelle

12.2 Configuration of the Modbus Server

The Modbus server can be configured via the configuration area in iRC. To do this, connect iRC to the
robot and open the Modbus configuration (file → Interface configuration → Modbus). The Modbus
server becomes active when the "Active" box is checked and "Apply" or "Save Project" is clicked. If
required, the port (default: 502) and the maximum number of connections can be changed.

12.3 TIA-Portal Library

For the implementation of the PLC side with a S7-1200 or S7-1500 CPU a library is available to the
user. The library contains data types and communication blocks. The download of the library can be
done via the following link.

https://wiki.cpr-robots.com/index.php/Modbus_Ser
ver

For including the library please contact the Siemens support.

https://support.industry.siemens.com/cs/ww/de/vi
ew/37364723

12.3.1 Creating the Robot Data Block

At first the insertion of a robot data block of type "CPR_ROBOT_MODBUS" is started. This data block
contains all important information and help for the later communication with the robot. The follow-
ing figure shows the robot data type. In the first place it contains a "TCON_IP_v4" object. This object
can be used to set the IP address of the robot and the port to use. The connection ID can also be set.
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If you have not changed the IP address of your robot, the corresponding addresses are already entered
in the default values. In the structure Data all entries from the Modbus mapping are accessible.

ð
Nomenclature
All data to send to the robot are marked with CMD or OUT. All data, from the robot
to the controller, are marked with Info or IN.

12.3.2 Inserting the Robot Communication FB

The FB CPR_Robot is responsible for communication with the robot. This function block requires the
following input signals.

Request_MB Bool Retrieve data from the robot. As long as this input is
set, the FB maintains active communication with the
robot.

Disconnect_MB Bool Disconnects the TCP/IP connection with the robot,
can be used for resetting errors

Reset Bool Resets the robot

Enable Bool Enables the robot

Reference Bool References all robot joints

StartProgram Bool Starts the robot program

StopProgram Bool Stops the robot program

Robot_Data CPR_ROBOT_MODBUS In/Out for the robot data block

The Robot_Data input provides the function block with all the data it needs to communicate with the
robot. By using several data blocks and CPR_Robot FB’s it is possible to communicate with several
robots at the same time. The following signals are available as outputs.

Enabled Bool Robot is enabled

Referenced Bool Robot is referenced

ProgrammRunning Bool The robot program is running

12.3.3 Data Access

To access the robot data, the data in the robot DB can be manipulated. These are then automatically
transferred to the robot and processed.

12.4 Address Mapping

This section describes the address allocation to allow own implementations and extensions of the
PLC function blocks.
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Modbus defines four memory areas that can be read and written by different messages. In the address
mapping of the igus robots, the areas are used as follows. In some cases information can be retrieved
both bitwise and as register.

Address section Access Usage

Coils 1 Bit, read and write Actions and changeable states

Discrete Inputs 1 Bit, read only States, information

Holding Registers 16 Bit, read and write Changeable values and states

Input Registers 16 Bit, read only Not changeable values, information

Table 26: Use of the Modbus address sections

The following Modbus function codes can be used to read and write the memory areas.

Address section Read Write

Coils 1 5 (single), 15 (multiple)

Discrete Inputs 2 -

Holding Registers 3 6 (single), 16 (multiple), 22 (masked), 23 (read and write)

Input Registers 4 -

Table 27: Supported Modbus function codes (decimal)

Since Modbus defines only 1-bit and 16-bit access, complex data types and actions are defined here
as follows:

Data type Description

boolean Writing bit "0" or "1" starts the corresponding action or sets the state.

enum Enumeration. Meaning depends on the register, see section 12.4.5.

Info Information, not writable

int32 / uint32 Two 16-bit registers, least significant register first.

rising edge Action is executed when first a 0 and then a 1 is written. Attention: Some coils
return the actual value when reading, not the last written one. In case of double
assignment (e.g. enable/disable motors) the action is chosen depending on the
actual state.

string character string. Two 8-bit characters per register, least significant byte first.
The string ends with a zero byte or when the maximum number of registers is
reached.

Table 28: Definition of complex data types

The following tables describe the Modbus address assignment version 1 (see input register 3).

12.4.1 Coils and Discrete Inputs - 1 Bit, Read Only

Via coils and discrete inputs 1-bit accesses are possible. This is used here to query inputs and outputs
as well as simple states and to trigger actions.
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ð
So that fewer Modbus messages have to be sent for reading, read access to 1-bit data
is possible both as coils and as discrete inputs. It should be avoided to read values as
discrete input, which were written as coil before. Therefore it is recommended to use
only the coil access.

Addresses Type Description

10 Info Has robot axes

11 Info Has external axes

12 Info Has gripper axes

13 Info Has platform axes

14 Info Has digital input/output modules

20 Info Modules - No error

21 Info Module error - Temperature

22 Info Module error - Emergency stop / undervoltage

23 Info Module error - Motor not activated

24 Info Module error - communication

25 Info Module error - contouring error

26 Info Module error - encoder error

27 Info Module error - overcurrent

28 Info Module error - driver error

29 Info Module error - Bus dead

30 Info Module error - module dead

31-36 Info Module error - reserved for future errors

37 Info Kinematics - no error

38 Info Kinematics - axis limit min

39 Info Kinematics - axis limit max

40 Info Kinematics - Central axis singularity

41 Info Kinematics - Out of range

42 Info Kinematics - wrist singularity

43 Info Kinematics - Virtual box reached

44 Info Kinematics - Movement not allowed

45-49 Info Kinematics - reserved for future errors

50 Is CAN bus connected? / Connect (1) / Disconnect (0) (Connect / Dis-
connect not possible with TinyCtrl)

51 Shutdown control computer

52 Robot reset

53 Are the motors active? / Enable motors (1) / Disable motors (0)

54 Info Normal operation (see operation mode, table 35)

60 Are all axes referenced? / reference

61-66 Is robot axis referenced? / reference

67-69 Is external axis referenced? / reference
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70-72 Is gripper axis referenced? / reference

73 Set all axes to 0

100 Start MoveTo - cartesian

101 Start MoveTo - Cartesian relative base coordinates

102 Start MoveTo - Cartesian relative tool coordinates

103 Start MoveTo - joint movement

104 Start MoveTo - joint movement relative

110 Info Is Zero-Torque (manual guidance mode) available?

111 boolean Is Zero-Torque enabled? / enable (1) / disable (0)

112 Info Is the robot moving?

120 Info Is a robot program loaded?

121 Info Is a logic program loaded?

122 Is the robot program running? / start / continue

123 Is robot program paused? / pause

124 Is the robot program stopped? / stop

130 Select next directory entry

131 Select previous directory entry

132 Info Is the selected directory entry a program file

133 Load selected directory entry as robot program / open directory

134 Go to the base directory (.../Data/Programs)

135 Unload robot program

136 Unload logic program

200-299 boolean Global signals

300-363 boolean Digital outputs

364-427 Info Digital inputs

Table 29: Assignment of coils and discrete inputs

12.4.2 Input Registers - 16 Bit, Read Only

The input registers provide read access to configuration, status and statistical information. To convert
numerical values into the correct unit, multiply by the factor specified under Unit. The meaning of
the state registers with data type enum is described in section 12.4.5.

Addresses Type Unit Description

0 uint16 Software ID (902=iRC, 980=TinyCtrl)

1 uint16 Software major version (e.g. 12)

2 uint16 Software minor version (e.g. 6)

3 uint16 Modbus mapping version

4-5 uint32 minutes Uptime complete

6-7 uint32 minutes Uptime last

8-9 uint32 minutes Uptime enabled

10-11 uint32 minutes Uptime movement
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12 uint16 Program starts

13 uint16 0.1ms Cycle time target

14 uint16 0.1ms Cycle time max (last 50 cycles)

15 uint16 0.01Hz Cycle frequency (average)

16 uint16 0.01% Workload

20 uint16 Number of robot axes

21 uint16 Number of external axes

22 uint16 Number of gripper axes

23 uint16 Number of platform axes

24 uint16 Number of input/output modules

25-30 bit field Module error codes robot axes

31-33 Bit field Module error codes external axes

34-36 bit field module error codes gripper axes

37-40 bit field module error codes platform axes

41-43 bit field module error codes input/output modules

44-49 int16 0.1°C Temperature electronics robot axes

50-52 int16 0.1°C Temperature electronics external axes

53-55 int16 0.1°C Temperature electronics gripper axes

56-59 int16 0.1°C Temperature electronics platform axes

60-65 int16 0.1°C Temperature motors robot axes

66-68 int16 0.1°C Temperature motors external axes

69-71 int16 0.1°C Temperature motors gripper axes

72-75 int16 0.1°C Temperature motors platform axes

76-81 uint16 mA Currents robot axes

82-84 uint16 mA Currents external axes

85-87 uint16 mA Currents gripper axes

88-91 uint16 mA Currents platform axes

92 uint16 0.01V Voltage

93 uint16 mA Total Current

94 uint16 0.1% Battery charge (not in TinyCtrl)

95 uint16 enum Kinematics - error code

96 uint16 enum Operating mode

130-135 int32 0.01mm Current Cartesian position

136-141 int16 0.01° Actual cartesian orientation

142-153 int32 0.01 Actual robot axis position

154-159 int32 0.01 Actual axis position ext. axes

160-165 int32 0.01 Actual axis position of gripper axes

166-173 int32 0.01 Actual axis position platform

262 uint16 Number of loaded robot programs

263 int16 Number of current program, 0 for main program

264 uint16 Number of instructions in current program
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265 int16 Number of current instruction, -1 if program is not running

266 enum Reason for last program stop or pause

331 uint16 Number of entries in current directory

333-364 string Name of the selected directory entry

365-396 string Name of the current directory

207-210 bit field Digital inputs

400-431 string Info/error message short (as on manual control unit)

440-455 int16 Number variables mb_num_r1 - mb_num_r16

456-711 int16 0.1 Position variables mb_pos_r1 - mb_pos_r16 (see sec. 12.4.4)

Table 30: Assignment of the Input Registers

12.4.3 Holding Registers - 16 Bit, Read and Write

Target positions and variables as well as the name of a program to be loaded can be written via the
holding registers.

Addresses Type Unit Description

130-135 int32 0.01mm Target position cartesian

136-141 int16 0.01° Target orientation cartesian

142-153 int32 0.01 Target position robot axes

154-159 int32 0.01 Target position external axes

174-177 int32 0.01mm Target position platform

178-179 int32 0.01° Target orientation platform

180 int16 0.1 Speed for MoveTo (percent or mm/s)

181-186 int32 0.1 Target velocity of ext. axes in velocity mode

181-186 uint16 0.01% Velocity override

188 enum Jog mode

260 enum Robot program RunState

261 enum Robot program Replay mode

267-298 string Name of loaded robot program / load on write

299-330 string Name of the loaded logic program / load on write

332 uint16 Number of the selected directory entry

200-206 bit field Global signals

207-210 bit field Digital outputs

440-455 int16 Number variables mn_num_w1 - mb_num_w16

456-711 int16 0.1 Position variables mb_pos_w1 - mb_pos_w16 (see sec.
12.4.4)

Table 31: Assignment of the Holding Registers
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12.4.4 Number and Position Variables

For communication with robot and logic programs, predefined program variables can be used in
addition to the global signals. For this purpose, 16 readable and 16 writable number and position
variables are available in each case.

Name Type Access via Modbus

mb_num_r1 - mb_num_r16 Number variable read only (input register)

mb_num_w1 - mb_num_w16 Number variable read and write (holding register)

mb_pos_r1 - mb_pos_r16 Position variable read only (input register)

mb_pos_w1 - mb_pos_w16 Position variable read and write (holding register)

Table 32: Program variables for communication via Modbus

ð
When using the PLC function blocks, only use the writable variables to send values from
the PLC to the robot. Do not change these variables in the robot program, as they are
regularly overwritten by the PLC.

�
Unlike normal program variables, the Modbus variables are always available. No pro-
gram has to be started and the variables do not have to be declared with the store state-
ment.

Each number variable is mapped in a register. Since only integers are supported here, the robot pro-
gram must convert to the desired value range by multiplication or division if necessary (Math instruc-
tion).
Position variables consist of 16 registers each, whose values are specified in tenth precision:

• 9 registers for robot and external axes (A1-A6, E1-E3).
• 3 registers for Cartesian position (X, Y, Z)
• 3 registers for Cartesian orientation (A, B, C)
• 1 register for selection of conversion type

According to the translation type, the kinematics converts from axis angles to Cartesian coordinates
or vice versa. This can be helpful if, for example, target positions are only available as coordinates,
but the robot is to move per joint instruction.

Value Meaning

0 No conversion, axis positions and Cartesian coordinates are taken over without any
change (default)

1 Cartesian coordinates and orientation are calculated from the axis positions

2 The axis positions are calculated from the Cartesian coordinates and orientation

Table 33: Conversion type

ð
Beachten Sie, dass möglicherweise nicht alle Positionen von der Kinematik erreicht
werden können. Prüfen Sie die Werte daher auf Plausibilität.
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12.4.5 Meaning of Enumeration Values

The following tables describe the meaning of the enumeration values (enums).

Value Meaning

0 No error

13 Axis limit Min

14 Axis limit max

21 Central axis singularity

22 Out of range

23 Wrist singularity

30 Virtual box violated in X+

31 Virtual box violated in X-

32 Virtual box violated in Y+

33 Virtual box violated in Y-

34 Virtual box violated in Z+

35 Virtual box violated in Z-

50 NAN in calculation

90 Motion not allowed

65535 (0xFFFF) Unknown error

Table 34: Kinematic error code

Value Meaning

0 Standard - normal operation

1 Serious error, control must be restarted

2 CAN-Bridge (CRI, e.g. retrieve firmware parameters)

Table 35: Operation mode

Value Meaning

0 Axes

1 Cartesian base coordinate system

2 Cartesian tool coordinates

3 Platform

0xFFFF Invalid

Table 36: Jog Mode

Value Meaning

0 Program is not running

1 Program is running
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2 Program paused

Table 37: RunState

Value Meaning

0 Run program once

1 Repeat program

2 Execute instructions step by step

3 Fast (not used)

Table 38: Replay Mode

Value Meaning

0 User (Teach pendant, CRI, Modbus, etc.)

1 PLC

2 Program (stop/pause instruction)

3 Replay Step (step operation)

4 Shutdown (system shuts down)

100 Error

101 Path generator error 1

102 Path generator error 2

103 Error in state machine

Table 39: Reason for last stop/pause of program
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13 Maintenance

13.1 Cleaning

• After the control unit is disconnected from the mains, it can be wiped with a damp cloth.
• After the control unit is disconnected from the mains, fans or ventilation slots can be cleaned

carefully with a damp cloth or light compressed air. In doing so, the rotors of the fans must be
held firmly so that they do not receive bearing damage due to excessive speed (rpm).
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14 Troubleshooting

14.1 Frequently Asked Questions

Antworten zu häufig gestellten Fragen finden Sie in unserem Wiki:

https://wiki.cpr-robots.com

14.2 Error Codes and Solutions

Our troubleshooting guide provides step-by-step assistance in identifying and solving problems:

https://wiki.cpr-robots.com/index.php/Troublesho
oting

Error codes and problems with hardware and electronics are described in the following article:

https://wiki.cpr-robots.com/index.php/Robot_Har
dware_Troubleshooting

Solutions to common software problems are described in the following article:

https://wiki.cpr-robots.com/index.php/CPRog_Sof
tware_Troubleshooting

14.3 Test Software Module Control

The Module Control software can be used to test axes individually and without the influence of the
robot control. Among other things, it enables the axis to be moved and referenced, and parameters
to be read out and changed (see section 11.6).
Module Control can be downloaded under the following link. The operation is also described there
in more detail.

https://wiki.cpr-robots.com/index.php/Config_Sof
tware_ModuleCtrl
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14.4 Support Contact

If you have any problems, we will be happy to help!
• igus Support landingpage:

https://www.igus.eu/info/igus-low-cost-automatio
n

• E-Mail: ww-robot-control@igus.net

�
In case of software problems, please send us the log files of the iRC - igus Robot
Control and the integrated controller. To do this, simply click on the question
mark at the bottom right of the 3D area to automatically attach all relevant files
to an e-mail

• Telephone: +49(0)2203 / 96498-255
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